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Introduction 
Hand Punch-32 (HP-32) is a software utility that enables the administration and integration of RSI Hand Punch 
hand reader terminals with third party time and attendance software. This is accomplished by retrieving data 
from the terminals in the system. Data received from the terminals is in simple ASCII format with one record per 
line, which then can be processed by third party software. 
 
Each time a terminal is used, a record of that use is stored in the terminal in the form of a message. These 
messages may record the enrollment of a person, a time punch, a supervisor override, or any other Command 
Mode activity at the terminal. When a terminal is polled, all messages are sent to the Host PC. Once the 
messages have been sent to the Host PC, they are deleted from the hand reader. In most cases, the message 
will be a time punch. At the Host PC, these messages are appended to the PUNCH.LOG and the 
YYYYMMDD.LOG files, where “YYYY” represents the year, “MM” represents the month and “DD” represents the 
day.  
 
The YYYYMMDD.LOG file is created for each day that the HP-32 software is run and only contains messages 
created that day.  
 
The PUNCH.LOG file will increase in size until it is processed and deleted. A list of all other terminal messages 
is stored in the SYS.LOG file and a list of system errors is contained in the ERR.LOG file. These files are all in 
simple ASCII format, with one record per line. These files can be viewed in the Text Window using the View 
menu or by using any text editor. 
 
User enrollments are handled differently than punch messages. An enrollment contains the ID Number of the 
employee and their enrollment hand template. When an enrollment message is received at the Host PC, the ID 
number and hand template are copied to the user database, USER. DAT. It is then checked for a matching ID 
number. If no matching number is found, the enrollment is stored in the user database, but is not transmitted to 
any other reader on the network. It will remain in the terminal until it is deleted. If a matching number is found, 
the template is placed in the database. HP-32 then determines which sites the hand template data should be 
downloaded to. This is defined in the Groups dialog box and is stored in the GROUP.TXT file. The hand 
templates are then downloaded to the appropriate Sites or terminals that are defined in the Sites and Clocks 
dialog boxes, which are stored in the SITE.TXT and CLOCK.TXT files. This allows users to access any terminal 
that is networked to the Host PC. 
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Layout Appearance 
The default main view of HP-32 consists of a Text Window, Title Bar, and Menu Bar.  
 

 
Text Window 
This window displays all current operations, configuration, data, and log files. This window can also be used as 
a text editor. 
 
Title Bar 
Located across the top of your screen, the Title Bar contains the currently displayed file. 
 
Menu Bar 
This menu contains a list of six drop-down menus, each with submenus listing additional options that will assist 
you in the administration and use of your Hand Punch. Below is an explanation of each of these menu items: 
 
File 
 

 
 
This menu contains the following basic Windows File commands: 
 
• New: Clears the Text Window. 
• Open: Opens a previously saved file. 
• Save: Saves the currently displayed file. 
• Save As: Saves the currently displayed file with a new name or directory path. 
• Exit: Exits the HP-32 software. 
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Edit 
 

 
 
The Edit menu consists of basic Windows editing commands and the Options command. The Options command 
is used to: 
 
• Set the directory path of the Data and Punch log files. 
• Enable or disable the New User Restriction. 
• Auto save the Command Line log file. 
 

 
 

Maintenance 
 

 
 
This Maintenance menu allows you to configure the user database and the terminals connected to the Host PC. 
 
• Sites: Define the terminals in the system by their location. 
• Bells: Create schedules when the Bell control output of a terminal is to be activated. 
• Holidays: Create or modify a holiday schedule. 
• Clocks: Set configuration settings of each terminal. 
• Groups: Group selected terminals together for polling and downloading data. 
• Users: Enroll users in the user database. 
• Time Zones: Allot time zones in which users can punch in at terminals. 
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Hand Punch 
 

 
 
The Hand Punch menu contains the commands that are used for communication between the Host PC and the 
connected terminals. 
 
• Poll: Used to retrieve punch data and hand templates from selected terminals. 
• Restore Database: Used to restore the hand template and user databases in selected terminals by 

downloading them from the Host PC. 
• Get Database: Retrieves hand templates from selected terminals of users who were previously enrolled in 

the user database, USER.DAT, at the Host PC. 
• Get Full Database: Retrieves hand templates from selected terminals of all users whether or not they are 

enrolled in the user database. 
• Send Time: Sends the Host PC date and time to selected terminals. 
• Send Config: Downloads the configuration files of selected terminals. 

 
View 
 

 
 
The View menu allows you to view the data and log files generated by HP-32 in the Text Window. The 
commands listed correspond to the following files: 
 
• Users List: USER.DAT 
• Punch Log: PUNCH.LOG 
• Today’s Punches: YYYYMMDD.LOG 
• Error Log: ERROR.LOG 
• System Log: SYS.LOG 
• Transaction Data: TRANS.DAT 
 
Help 
 
The About selection in the Help menu displays the version number of software. This information is required 
when placing a support call. 
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Getting Started 
Overview 
The basic setup steps for HP-32 are as follows:  
1. Enroll users in the database at the Host PC or pre-enroll users at the Hand Punch terminals. 
2. Create Sites, Terminal Configurations (Clocks), Time Zones, Bell Schedules, Holidays, and Groups. 
3. Test communications between the Host PC and the connected terminals. 
4. Poll the terminals to upload any enrollment information. 
5. Send terminal configuration, system time and date, and database information from the Host PC to the 

connected terminals. 
  
Users 
Users can be added to the system by either pre-enrolling them at the Hand Punch terminal or by adding them 
directly to the user database at the Host PC. 
 
Pre-enrollment 
The pre-enrollment process consists of adding users to a Hand Punch terminal (ID Number and hand template) 
without adding their record to the user database, USER.DAT. Refer to your Hand Punch terminal’s 
documentation for the enrollment procedure. When the terminal is polled and an enrollment message is 
received for an ID number that does not exist in the user database, HP-32 will then create a user record for that 
ID Number and store the hand template in the database. Since there is no record of the user, there is no 
definition of their time zone or group number. The hand template for the user will remain in the hand reader that 
they are enrolled in, because the database does not know which terminals the user’s template should be 
distributed to. 
When the pre-enrolled ID number is entered into the user database through the Users dialog box, and the Get 
Database command is run, the user’s hand template will be uploaded to the database. 
 
Enrollment 
Users are enrolled at the Host PC through the Users dialog box, which is accessed from the Maintenance menu. 
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To add a user, click on the New  button, and enter the following: 
 
User ID User ID number. May be up to 10 digits long. 

Time Zone/Group Select the Time Zone to be assigned to this user. Valid Time Zone numbers are 0 thru 
61. 0 = always, 61 = never 

Reject Override Enter the sensitivity of the terminal to the user’s hand geometry. Permitted values are 
40 through 200. The default is 125. 
This drop down list enables you to assign an Authority Level or Command Mode Group 
to the employee. These groups allow access to commands in the RSI Hand Punch for 
employee enrollments, system management, and service operations. Refer to your 
terminal’s documentation for detailed information on each group’s functions, operations, 
and structure. 
None No Command Mode Group is assigned. 
Security Disable the hand reading checks in the terminal. 
Enrollment Enroll and remove users. 
Management General system management operations 
Setup Set the baud rate and number of the terminal. 

Authority Level 

Service Access to service and diagnostic functions. 
Comment Text field for comments. 

After you have entered the desired information, click on the Save  button. If a field is left empty, the 
default value of the field will be assigned. This information is saved to the USER.DAT and USER.TXT files. 
 
Modifying a User 
To edit a User, select the User number from the drop down list. When you have finished modifying the User 

information, click on the Save  button. 
 
Deleting a User 

To delete a User, select the desired User number from the drop down list and click on the Delete  
button.  

To exit the User dialog, click on the Close  button. 
After all users have been enrolled in the user database, they should be enrolled at the terminal. Any of the 
system terminals may be used for enrollment. 
 
Global 

If you want to globally apply any of the above fields to all users, click on the Global  button. Once 
you have made your selections, click on the OK button. 
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Sites 
A Site is used by HP-32 for communications between the Host PC and the terminals. Up to 31 terminals can be 
included in each Site. 
 
Creating a Site 
 

 
 

To create a Site, click on the New  button. 
In the Site field, enter a number that will be used to identify the Site. Valid numbers are 1 thru 999. 
In the Description field, enter a description for the Site. 
If there is a difference between the Host PC’s time and the Site’s time, you must select the number of hours 
difference from the Time Zone Adjust drop down list (-23 to +23, “-“ sign must be included when applicable). If 
this field is left blank, the Host PC’s system time is sent to the terminal. For example, if your host resides in 
California and your site is in New York, you would use a value of +3. When HP-32 sends the system time and 
date to that Site, three hours will be added to the current time (in California) before sending it to the site (in New 
York). 
Select the COM Port (COM1, COM2, etc.) and Baud Rate (1200, 2400, 4800, and 9600) of the device that your 
Host PC is using to communicate with the terminal(s) at the site. If the Modem and Network information is left 
blank, HP-32 will assume that the terminal(s) at the site are directly connected to the Host PC. 
If you are using a modem to communicate with the terminals at the site, you must enter the modem initialization 
string, modem dial command, and telephone number of the terminal. Refer to your modem’s documentation for 
the modem string and dial commands. If you are communicating with the terminals over a network, enter the IP 
Address of the terminal’s ethernet card. 

After you have entered the desired information, click on the Save  button. This information is stored 
in the SITE.TXT file. 
 
Modifying a Site 
To edit a Site, select the Site number from the drop down list. When you have finished modifying the Site 

information, click on the Save  button. 
 
Deleting a Site 

To delete a Site, select the desired Site number from the drop down list and click on the Delete  
button.  

To exit the Sites dialog click on the Close  button. 
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Clocks 
The configuration parameters of each terminal in a Site are set in the Clocks dialog box. Once saved, this 
information is stored in the Clock definition (CLOCK.TXT) and Hand Punch Configuration (HP.CFG) files. To 
access this dialog box, select the Clocks option in the Maintenance menu.  
 

 
 

To set the configuration parameters of a specific terminal, click on the New  button, and enter the 
following information: 
Site Select a Site number from the drop down list.  
Clock No. Select the desired clock or terminal number within the Site. 

The following fields are used to assign the Command Mode Group passwords for the 
selected terminal. Each password may be up to 10 digits long.  

None No Command Mode Group is assigned. 

Security Disables the hand reading checks in the terminal. 

Enrollment Enroll and remove users. 

Management General system management operations 

Setup Set the baud rate and number of the terminal. 

Passwords 

Service Access service and diagnostic functions 

Daylight Savings 
Time (DST) 

Specifies the time at which the clock is advanced (On) or moved back (Off) one hour for 
DST. Dates and times should be entered in MO:DD:HH:MM format. If the DST On and 
Off times are not specified, no DST adjustment will be made. 

Comment Text field for user comments. 
Display Specifies the terminal’s time display format: 0 = 24 hour or 1 = 12 hour. 

Select one or both of the following data entry modes: 

Explicit 
Punch If checked, the Explicit Punch Menu will be enabled at the terminal. 

Punch Mode 
Department 
Code 

If checked, a Department Code will be requested each time a user 
punches; otherwise the user must press the # key once before entering 
their ID number to display the Department Code prompt. 
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Reject Threshold The sensitivity of the terminal to the user’s hand geometry. Permitted values are 40 
through 200. The default is 125. 

Lock Control The duration, in seconds, that the Lock Control output of the terminal will be activated. 
The default is 10 seconds. 

ID Length 
The User ID number length. Permitted values are 1 through 11, with the default being 
11. 10 digits are the maximum in any case, but if 11 are specified, the enter key (#) 
must be pressed after the 10th digit is entered.  

Access Tries The number of attempts a user is permitted to try hand readings before being refused. 
The default is 6. 

Bell Schedule Specifies the Bell Schedule. 

Function Keys 
This allows you to select files created with the Function Key Compiler. By default, the 
drop down list is empty. Files may be added to the list by placing them in the HP-32 
program directory. 

Keypad Beeper When checked (default), the beeper on the terminal will be enabled.  
 

If a field is left empty, a default value will be assigned.  

After you have entered the desired information, click on the Save  button. 
 
Modifying a Terminal Configuration 
To edit a terminal configuration, select the Site and Clock number from the drop down lists. When you have 

finished modifying the configuration, click on the Save  button. 
 
Deleting a Terminal Configuration 
To edit a terminal configuration, select the Site and Clock number from the drop down lists, and click on the 

Delete  button.  

To exit the Clocks dialog box, click on the Close  button. 
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Bells 
A Bell schedule is used specify when the bell output of the terminal is to activate the bell and its duration. Up to 
100 activations can be defined for a schedule and only one schedule can be assigned to a terminal.  

Creating a Bell Schedule 
To create a Bell schedule, select the Bells command from the Maintenance menu. The Bells dialog box will 
appear: 

 
 

To create a Bell Schedule, click on the New  button. 
In the Bell Schedule field, enter a number to be used to identify the schedule. Valid numbers are 0 to 32766. 
Enter the hour and minute at (24-hour format, HH:MM) in the Time field to specify when the bell output will be 
activated. 
In the Duration field, enter the time or duration (1 to 31 seconds) that the bell output will be activated. 
Check the days of the week that the bell output will be activated. “Hol” corresponds to Holidays that are 
specified in the Holidays definition.  

After you have entered the desired information, click on the Save  button. The Bell schedule will 
appear in the text window in the lower half of the dialog box. 
 
Modifying a Bell Schedule 
To edit a Bell schedule, select a schedule number from the Bell Schedule field or from the list in the lower text 

window. When you have finished modifying the schedule, click on the Save  button. 
 
Deleting a Bell Schedule 
To delete a Bell Schedule, select a schedule number from the Bell Schedule field or from the list in the lower 

text window and click on the Delete  button.  

To exit the Bells dialog box, click on the Close  button. 
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Holidays 
The Holiday Definition specifies days that will be treated as holidays. 
 

 
 

To add a holiday, select a day of the month and click on the Add  button. The date selected will 
appear in the Holidays list. The  and  icons are used to move the month forward or backward. 

To delete a holiday, select a date from the Holidays list and click on the Remove  button. 

To exit the Holidays dialog, click on the Close  button. 
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Time Zones 
The time intervals that users are allowed to punch at a terminal are controlled by Time Zones. Each user is 
assigned a Time Zone. A Start Time, a Stop Time (HH:MM) and the days of week define each time interval. Up 
to four intervals can be created per Time Zone.  
Time Zones are created in the Time Zones dialog box, which is accessed through the Maintenance menu. 
 

 

To create a Time Zone, click on the New  button. 
In the Time Zone field, enter in a number that will be used to identify the Time Zone. Valid numbers are 1 thru 
60. There are two special Time Zones, 0 and 61. Time Zone 0 is reserved for always active (punch anytime), 
and Time Zone 61 is never active. 
Enter a Start and Stop time (in 24 hour format, HH:MM) for Time 1. Place a check in each day of the week that 
this interval will be active. Hol corresponds to any day specified as a holiday in the Holiday dialog box. Repeat 
for Times 2 through 4 if necessary.  
A Time Zone that will cross the Day Change Time of midnight must be split up into two intervals. For example, a 
Time Zone cannot be configured to have a start time of 23:00 and a stop time of 01:00. To set up this Time 
Zone, you must set Time 1 to start and end at 23:00 and 23:59 and Time 2 to start and end at 00:00 and 01:00. 
Time Zones are rounded to tenths of an hour (6 minute intervals) at the terminal. For example, if 08:15 is 
entered as a Start time, it will be rounded to the nearest tenth of an hour and be sent to the Hand Punch as 
08:18.  
If no Time Zone is created or assigned to a user, then the default is Time Zone 0. 

When you have finished making your selections, click on the Save  button. 
 
Modifying a Time Zone 
To edit a Time Zone, select the Time Zone number from the drop down list. When you have finished modifying 

the Time Zone, click on the Save  button. 
 
Deleting a Time Zone 
To delete a Time Zone, select the Time Zone number from the drop down list, and click on the Delete 

 button.  

To exit the Time Zone dialog box, click on the Close  button. 
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Groups 
A Group is a collection of terminals for user assignments. Groups may consist of terminals from different Sites. 
Groups are created in the Groups dialog box, which is accessed from the Maintenance Menu. 

 

 
 
Creating a Group 

Click on the New  button and enter the following: 
 
Group Number Enter a number for the Group. Valid numbers are 100 through 255. 
Site Number Select a Site Number from the drop down list. 
Clock Number Select the desired clock number within the Site. 

Time Zone Select the Time Zone to be applied to this Site or selected terminal within the Site. Valid 
Time Zone numbers are 1 thru 61. 0 = always, 61 = never 

Comment Text field for user comments. 

When you have finished entering the above information, click on the Save  button. The Group info 
for the Site or terminal entered will be displayed in the Group List. This information is saved to the GROUP.TXT 
file, which may be viewed in the Text Window by using the Open command in the File menu. 
To add additional Sites or terminals to a Group, repeat the steps above for other Sites or terminals. 
 
Modifying a Group 
To edit a Group, select a Group number from the drop down list in the Group field or an entry from the Group 

list. When you have finished modifying the Group, click on the Save  button. 
 
Deleting a Group 
To delete a Group, select a Group number from the drop down list in the Group field or an entry from the Group 

list, and click on the Delete  button.  

To exit the Bells dialog box, click on the Close  button. 
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Communications 
These commands, located in the Hand Punch menu, are used to send, restore, and retrieve user, terminal, and 
transaction data from selected Sites or terminals. 
 
Poll 
The Poll command is used to upload transaction data and biometric hand templates from selected terminals to 
the Host PC. When a site is polled, all transactions recorded since the last time it was polled are retrieved. 
Punch transactions are appended to the PUNCH.LOG and YYYYMMDD.LOG files. A new YYYYMMDD.LOG 
file is created for each day. If any new users were enrolled, their hand template data is retrieved and written to 
the USER.DAT file. Additionally, all hand templates for users that have punched are retrieved and their 
associated records in the USER.DAT file are updated with the latest templates. 
 

 
 

Restore Database 
This command is used to restore the hand template database to a terminal. This is done by first clearing the 
database in the selected terminal(s) and then downloading previously assigned hand templates from the 
USER.DAT file from the Host PC. 
 

 
 

Get Database 
This command is used to retrieve hand templates from selected Sites or terminals for all users that are only 
enrolled in the USER.TXT file on the Host PC. This allows the USER.DAT file to be updated with the most 
current hand templates.  
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Get Full Database 
This command is used to retrieve hand templates from selected Sites or terminals for all users regardless if they 
are enrolled in USER.TXT file on the Host PC. 

 

 
 
Send Time 
This command sends the Host PC date and time to the selected Sites or terminals. 
 

 
 
Send Config  
This command downloads configuration data stored in the file HP.CFG to the specified terminals. The data 
stored in the HP.CFC file is entered in the Clock, Bells, Time Zone, and Holiday dialog boxes. 
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Test Communications 
This command is used to initiate a communications test for selected terminals. 

 
 

The results of the communications test will appear in the Text Window: 
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View 
The following commands in the View menu allow you to display user, system, configuration, and transaction 
data in the Text Window. 
 
User List 
This command allows you to view the contents of the USER.DAT file. 
 

 
 
Punch Log 
This command allows you to view the contents of the PUNCH.LOG file. User punches at a terminal are written 
to this file when terminal data is retrieved by the Poll command. 
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Today’s Punches 
This command allows you to view the contents of the YYYYYMMDD.LOG file. The user punches at the terminal 
are written to this file when the terminal data is retrieved by the Poll command. 
 

 
 

Error Log 
This command allows you to view the ERROR.LOG file. 
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System Log 
This command allows you to view the SYS.LOG file. 
 

 
 

Transaction Data 
This command allows you to view the TRANS.DAT file. 
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Command Prompt Operation 
HP-32 can be run directly from the Host PC’s DOS Command Prompt. Because of this, specific tasks in HP-32 
can be performed from Desktop shortcuts or automatically through any Windows-based scheduling utility. 
 
To run HP-32 directly from the Command Prompt, perform the following: 
1. From the Start menu, select Programs|Accessories|Command Prompt. The Command Prompt window will 

appear: 

 
2. At the prompt, move to the Hand Punch32 directory. 
3. Enter the desired command from the chart listed below. Commands must be separated by spaces, and are 

in the following format: 
HPUNCH32.EXE P00101 T 

The above command instructs HP-32 to Poll Site 1, Terminal 1 and then sends the time to all sites. The Site 
Number and Terminal Number must have leading zeros. 
 

Command Description 
P[sss[rr]] Poll site/reader 
C[sss[rr]] Send configuration to site/reader 
T[sss[rr]] Send time to site/reader 
R[sss[rr]] Restore Database to site/reader 
G[sss[rr]] Get Reader Database (user.txt users only) 
F[sss[rr]] Get Full Reader Database (All templates) 
X[sss[rr]]   Test communications 

Where sss = Site Number and rr = Clock or Terminal Number 
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